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Notices 
© Agilent Technologies, Inc. 2017 

No part of this manual may be 
reproduced in any form or by any 
means (including electronic storage 
and retrieval or translation into a 
foreign language) without prior 
agreement and written consent from 
Agilent Technologies, Inc. as governed 
by United States and international 
copyright laws. 

Manual Part Number 
G5182-90003 

Edition 
First edition, May 2017 

Agilent Technologies Australia [M] Pty 
Ltd. 
679 Springvale Road 
Mulgrave, Victoria, 3170 Australia 

www.agilent.com 

Warranty 
The material contained in this 
document is provided “as is,” and is 
subject to being changed, without 
notice, in future editions. Further, to 
the maximum extent permitted by 
applicable law, Agilent disclaims all 
warranties, either express or implied, 
with regard to this manual and any 
information contained herein, 
including but not limited to the 
implied warranties of merchantability 
and fitness for a particular purpose. 
Agilent shall not be liable for errors 
or for incidental or consequential 
damages in connection with the 
furnishing, use, or performance of 
this document or of any information 
contained herein. Should Agilent and 
the user have a separate written 
agreement with warranty terms 
covering the material in this 
document that conflict with these 
terms, the warranty terms in the 
separate agreement shall control. 

Technology Licenses 
The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance 
with the terms of such license. 

Restricted Rights Legend 
If software is for use in the 
performance of a U.S. Government 
prime contract or subcontract, 
Software is delivered and licensed as 
“Commercial computer software” as 
defined in DFAR 252.227-7014 (June 
1995), or as a “commercial item” as 
defined in FAR 2.101(a) or as 
“Restricted computer software” as 
defined in FAR 52.227-19 (June 1987) 
or any equivalent agency regulation or 
contract clause. Use, duplication or 
disclosure of Software is subject to 
Agilent Technologies’ standard 

commercial license terms, and non-
DOD Departments and Agencies of the 
U.S. Government will receive no 
greater than Restricted Rights as 
defined in FAR 52.227-19(c)(1-2) (June 
1987). U.S. Government users will 
receive no greater than Limited Rights 
as defined in FAR 52.227-14 (June 
1987) or DFAR 252.227-7015 (b)(2) 
(November 1995), as applicable in any 
technical data. 

Safety Notices 

A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not 
proceed beyond a CAUTION notice 
until the indicated conditions are fully 
understood and met. 

A WARNING notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered 
to, could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.

CAUTION 

WARNING 
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This chapter introduces the following topics: 

 OpenLAB ECM 

 The integration of UV-Visible ChemStation with OpenLAB ECM 

 The requirements of 21 CFR Part 11. 
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What is OpenLAB ECM? 
The Agilent Enterprise Content Manager (ECM) is a web-based electronic library 
that allows you to safely archive and catalog any electronic file. ECM allows you 
to store and index analytical raw data, reports, and all other types of documents. 
The stored files can be shared with other users.  

You can store any electronic file type, such as Microsoft Office documents, Adobe 
PDF documents, images, and molecular drawings, as well as raw data and 
reports generated by UV-Visible ChemStation. 

ECM allows you to easily collect, organize, search, and review all of your data. It 
automatically extracts searchable metadata from files, and provides powerful 
search capabilities. In addition, ECM provides embedded viewers for many file 
types. 

The ECM interface is opened via Microsoft Internet Explorer, also referred to as 
the ECM Web Client. 

Add-On Solution for UV-Visible ChemStation: OpenLAB ECM Compliance Pack 
Starting with revision B.04.01, Agilent UV-Visible ChemStation provides an 
interface to the Agilent Enterprise Content Manager (ECM), which enables you to 
store analytical data and reports in a secure location. From UV-Visible 
ChemStation, you can log in to OpenLAB ECM and store methods, data files and 
reports. UV-Visible ChemStation data stored in OpenLAB ECM can later be 
downloaded back to UV-Visible ChemStation for review at any time. 

Since revision B.05.01, UV-Visible ChemStation with the OpenLAB ECM 
Compliance Pack Add-On offers the following features for compliance with 21 
CFR Part 11 and similar regulations for electronic records and electronic 
signatures: 

 Mandatory login/connection to OpenLAB ECM 

 Configurable session locking 

 Configurable UV-Visible ChemStation user roles and privileges 

 Full data traceability through a UV-Visible ChemStation audit trail 

 Full data versioning though the OpenLAB ECM database 

The OpenLAB ECM Compliance Pack Add-On requires the following 
components: 

 OpenLAB ECM Server 

 OpenLAB ECM Web Client installed on the UV-Visible ChemStation 
computer 
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 UV-Visible ChemStation with the OpenLAB ECM Compliance Pack installed 
on the UV-Visible ChemStation computer 

 A connection between the UV-Visible ChemStation computer and the 
OpenLAB ECM Server 

The main workflows for the transfer of raw data and methods are listed below. 
These workflows indicate the system activities in relation to the work processes. 

Overview of data-related workflows  

Workflow 1: Data acquisition and transfer to OpenLAB ECM  

1 The user is prompted to create a file. 

2 Analytical data is acquired using UV-Visible ChemStation. 

3 Data is temporarily saved to a secure location on the workstation. 

4 At the end of the data acquisition the user is prompted to save the file to the 
OpenLAB ECM. The file must be saved before any other function can be 
performed in the UV-Visible ChemStation software.  

5 A new OpenLAB ECM data set is created in the defined location as a UV-
Visible ChemStation results file. The data set includes method, data and 
results, as a *.SSIZIP along with the application audit trail and signature 
logbook. 

Workflow 2: Data acquisition using UV-Visible ChemStation Automation and automatic 
transfer to OpenLAB ECM  

1 An automation method is generated by a user with the appropriate privileges 
and uploaded to OpenLAB ECM. The ECM > Configure menu in UV-Visible 
ChemStation is used to define where the file is to be saved.  

2 A user with the appropriate privileges loads the method and executes the 
automation. 

3 Data is temporarily saved to a secure location on the workstation until the 
data acquisition is complete. 

4 A new Results file comprising the method, data, associated audit trail and 
signature logbook is automatically uploaded to OpenLAB ECM to the 
configured location defined in the method file. The file must be saved before 
any other function can be performed in the UV-Visible ChemStation software.  
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Workflow 3: Data acquisition using an existing UV-Visible ChemStation results file 

1 An existing UV-Visible ChemStation results file is loaded from the OpenLAB 
ECM. It contains method, data, audit trail information and associated 
signature logbook. 

2 The user makes changes to this results file by collecting more data, changing 
the method or reanalyzing the existing data. 

3 The new results file is saved using the File > Save Results command in UV-
Visible ChemStation (or saved with the same file name). 

4 A new revision of the same results file is created in the OpenLAB ECM 
database. The file must be saved before any other function can be performed 
in the UV-Visible ChemStation software.   

For more details, and for additional workflows, refer to Data-related workflows 
on page 36.  

Overview of workflows for methods 

Workflow 1: Uploading a new method 

1 A new method is created by a user with the appropriate privileges. 

2 The method is uploaded to OpenLAB ECM using the path selected by the 
user. 

3 Revision 1 of the method with the associated audit trail is automatically 
created in ECM. 

Workflow 2: Saving a changed method 

1 An existing method is loaded from OpenLAB ECM. 

2 The method is edited by a user with the appropriate privileges and the 
changed method is saved to OpenLAB ECM. 

3 A new revision of the method with the associated audit trail is automatically 
created in OpenLAB ECM. 

For more details, and for additional workflows, refer to Workflows for Methods 
on page 38. 
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Data Storage in OpenLAB ECM 
OpenLAB ECM provides a four-level data storage model consisting of Locations, 
Cabinets, Drawers and Folders. The Location, Cabinet, Drawer and Folder names 
together comprise the path name (called either LCDF path or Remote Data Path) 
of the storage location. Data is stored at Folder level only.  

The LCDF structure can be created using the ECM Web Client. You can also 
create additional Locations, Cabinets, Drawers, and Folders using the 
ChemStation Remote Data Path and you can set predefined tokens for the 
Drawers and Folders in ChemStation. 

In the OpenLAB ECM tree view, paths are denoted as follows: 

• Locations are denoted by a house icon 

• Cabinets are denoted by the file cabinet icon 

• Drawers are denoted by the drawer icon 

• Folders are denoted by the folder icon.  

The entire content structure appears in the Content book. 

21 CFR Part 11 Compliance 
Effective August 20, 1997, the U.S. Food and Drug Administration (FDA) 
released and published a new rule to enable pharmaceutical companies to 
approve their results with electronic signatures and to transfer paper-trail 
documentation into electronic records. This rule is known as 21 Code of Federal 
Regulations Part 11 (referred to as 21 CFR Part 11) and applies to all industry 
segments regulated by the FDA. 

21 CFR Part 11 includes the US Federal guidelines for storing and protecting 
electronic records and applying electronic signatures. The intent is to ensure 
that electronic records subject to these regulations are reliable, authentic, and 
maintained with high integrity. 

UV-Visible ChemStation B.05.01 or greater, with the OpenLAB ECM Compliance 
Pack Add-On, provides the necessary controls for managing system access, audit 
trail functions, versioning of UV-Visible ChemStation data, and electronic 
signature functions. Agilent OpenLAB ECM provides secure record keeping and 
data archival functionality. Agilent OpenLAB ECM is proven and has been 
deployed at many leading life sciences companies to satisfy compliance 
mandates for 21 CFR Part 11. 
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2. Installation 
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This chapter describes the installation and configuration of the UV-Visible 
ChemStation OpenLAB ECM Compliance Pack Add-On. 
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Compatibility 
The UV-Visible ChemStation OpenLAB ECM Compliance Pack Add-On for 
UV-Visible ChemStation B.05.03 is compatible with the following configurations: 
 

ECM Version ECM Server Operating Systems Supported UV-Visible ChemStation 
Operating Systems (OS) 

3.4.1 HF4 SP2 Microsoft Server 2008 R2 64-bit Windows 7 Professional or Enterprise 
(SP1) 64-bit  

3.5 HF3 Microsoft Server 2012 R2 64-bit Windows 7 Professional and Enterprise 
(SP1) 64-bit Windows 10 Professional 
and Enterprise 64-bit  

The UV-Visible ChemStation OpenLAB ECM Compliance Pack Add-On is not 
supported in combination with the UV-Visible ChemStation Security Pack. 

Installation and Configuration Tasks on the Server 
You must execute the database script for UV-Visible ChemStation on the 
OpenLAB ECM Server to implement UV-Visible ChemStation related users, roles 
and privileges.  

CAUTION If upgrading from a previous version of UV-Visible ChemStation the existing database 
scripts must first be deleted using the Delete Privileges script otherwise the new users, 
roles and privileges will not be applied. 

 

In addition, after installing the program, you must adjust several settings. 

Updating roles in existing OpenLAB ECM Accounts 

After updating the OpenLAB ECM Database with the UV-Vis Roles, it is 
necessary to perform a “Reset Roles” action in order for these to apply within 
existing ECM accounts. New ECM accounts, on the other hand, will get the 
updated roles without the need of performing a reset. If you create a new 
OpenLAB ECM account, these roles and their privileges are automatically 
available in that new account. However, if you want to use UV-Visible 
ChemStation with an existing OpenLAB ECM account, you must first reset the 
roles in that specific account. The new UV-Visible ChemStation roles and their 
privileges will be available only after resetting the roles for the existing account. 
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WARNING All system roles will be reset to default when performing Reset Role. If you made manual 
changes to a system role, these changes will be lost and any other manually created roles 
will be deleted. 

1 Open a browser window and connect to the ECM Web Server. 

2 Log in to the ECM Account for which you want to update the roles. 

3 Select the Administration tab. 

4 Click Account Administration. 

5 Double-click Users > Groups > Roles. 

The Account Administration dialog opens. 

6 Select the Roles tab. 

7 Click Reset Roles.  

The default UV-Visible ChemStation roles and the related UV-Visible 
ChemStation privileges are now available in the current account and can be 
assigned to users. 

Configuring users, roles and privileges 

About users, roles, and privileges 

In OpenLAB ECM, you can either create specific OpenLAB ECM users or operate 
with the Windows users. Each user can be member of a specific group. The 
available groups depend on the OpenLAB ECM configuration.  

You must assign a specific OpenLAB ECM role to each group. You can also assign 
roles to single users, however, for the sake of clarity we recommend that you 
assign roles only on the group level.  

The roles are equipped with numerous privileges, which define what the users 
are allowed to view or do in OpenLAB ECM and in UV-Visible ChemStation.  

NOTE Once you create a new OpenLAB ECM user, group, or role, you cannot delete it. You can only 
deactivate the unused item. 
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Default roles and privileges 

There are a number of default roles and privileges in OpenLAB ECM that are 
created during the installation of OpenLAB ECM and UV-Visible ChemStation 
OpenLAB ECM Compliance Pack. The following table shows an overview of these 
roles and privileges. 
 

Name Description 

Starting with “UV:” Default UV-Visible ChemStation roles and privileges related 
to UV-Visible ChemStation. 
Can be restored by the Reset Roles function. 
For details of the UV-Visible ChemStation privileges, see the 
Appendix on page 51. 

Starting with “:” Default ECM role. Can be restored by the Reset Roles 
function. 

Starting with “Content:” Privilege related to ECM 
Starting with “System:” Privilege related to ECM 

In addition, you can create your own roles in OpenLAB ECM, or grant further 
privileges to the default roles. For detailed information, refer to the ECM 
Administrator’s Guide. 

Assigning roles 

Users do not need any specific role in order to log in to OpenLAB ECM. However, 
in order for users to see a particular Location, Cabinet, Drawer, or Folder in the 
user interface, they must have the :Reader role as a minimum requirement. As a 
result, domain users with no global roles might not be able to view anything in 
the content unless they were granted the appropriate privileges. 

You should grant the users of the UV-Visible ChemStation Compliance Pack the 
:Contributor role. This can be done at the global level for the entire ECM 
Account, or individually for specific folders (see Roles and folders on page 48). 
The :Contributor role allows the user to view and add content to ECM. The 
:Contributor role should be enhanced with the Content: Add Folder privilege. 
This allows ChemStation ECM users to add folders to the LCDF hierarchy. 

NOTE If the role does not include the Add Folder privilege, the users cannot add a new Remote 
Data Path (LCDF) in ChemStation. 
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In addition to the OpenLAB ECM roles, users of UV-Visible ChemStation must be 
assigned at least one of the UV-Visible ChemStation roles or another, customized 
role with UV-Visible ChemStation privileges. Users without any UV:Privileges 
will not be able to log in to the UV-Visible ChemStation software. 

There is a complete list of all UV-Visible ChemStation roles and all relevant 
privileges in the Appendix on page 51. The privileges are set in the OpenLAB 
ECM server Administration tab and define which functions can be used in UV-
Visible ChemStation. Before running UV-Visible ChemStation, ensure that a user 
has been configured with login credentials and the appropriate UV:Roles and 
UV:Privileges. For more information, see Users/Groups/Roles on page 47. 

Installation Tasks on the ChemStation Computer 
UV-Visible ChemStation OpenLAB ECM Compliance Pack (G5182AA) is an Add-
On that can be installed at the same time as the UV-Visible ChemStation software 
by entering a valid license number at the start of the installation process. If UV-
Visible ChemStation is already installed on the client PC, it must be upgraded 
(G1102AA) to the latest version for access to the OpenLAB ECM database. Do 
not install the OpenLAB ECM Compliance Pack Add-On if no ECM server is 
available as this will cause an application error. 

Installing the ChemStation Software 

1 Log on as local administrator to your PC. 

2 Insert the Agilent UV-Visible ChemStation DVD.  

3 Click Yes when the User Account Control dialog appears. 

4 Navigate to the Setup folder on the installation DVD and then run Agilent UV 
ChemStation Rev. B.05.03 [21].exe. 

5 On the InstallShield Wizard click Next. 

6 Read the License Terms and click Yes to accept. 

7 Accept the default installation folder C:\Chem32. 

NOTE ChemStation MUST be installed to the default location. 

8 Click Next to continue. 

9 Select all software components you want to install. 
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Figure 1. UV-Visible ChemStation software component selection 

10 Enter a Licence Key then click Add License. 

11 Repeat the License Key entry until all Licenses are added for your selected 
products then click Next. 

The Configuration Editor is automatically launched to configure your 
installation. You can either configure the system now, following the 
instructions in the spectrophotometer installation guide or close the window 
to continue installing the software and configure the system later.  

NOTE The installation will not continue until the Configuration Editor has been closed. . 

 

NOTE Editing the instrument configuration in the Configuration Editor must be performed by a user 
logged onto the client PC as the administrator account, ChemStationSystem or the local 
administrator account that installed ChemStation. 
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12 Wait until the InstallShield Wizard’s completion dialog is displayed then click 
Finish. 

The system will reboot. 

13 After the installation is completed, run the Installation Verification by 
selecting Start > All Programs or All Apps > UV-Visible ChemStation > 
Installation Qualification. 

The software has been installed without errors when the message line 
Installation Verification completed successfully is displayed at the bottom 
of the ChemStation Installation Verification dialog. 

Adding the Compliance Pack to an installed ChemStation 
To add the Compliance Pack to previously installed UV-Visible ChemStation: 

1 Log on as local administrator to your PC 

2 Insert the Agilent UV-Visible ChemStation DVD and run setup.exe. 

3 In the Welcome dialog of the InstallShield Wizard select the Modify option 
and click Next. 

4 In the Select Components dialog of the InstallShield Wizard select the 
G5182AA Compliance Pack Add-on option and click Next. 
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Figure 2. UV-Visible ChemStation software components selection 

5 Enter your License Key in the Enter License Information dialog, click Add 
License and then Next.  

The Configuration Editor is automatically launched to configure your 
installation.  

You can either configure the system now, following the instructions in the 
spectrophotometer installation guide, or close the window to continue 
installing the software and configure the system later.  

NOTE The installation will not continue until the Configuration Editor has been closed. . 

 

NOTE Editing the instrument configuration in the Configuration Editor must be performed by a user 
logged onto the client PC as the administrator account, ChemStationSystem or the local 
administrator account that installed ChemStation. 
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6 Wait until the InstallShield Wizard’s completion dialog is displayed then click 
Finish. 

The system will reboot.  

The software has been installed without errors when the message line 
Installation Verification completed successfully is displayed at the bottom 
of the ChemStation Installation Verification dialog. 

7 After the installation is completed, run the Installation Verification by 
selecting Start > All Programs or All Apps > UV-Visible ChemStation > 
Installation Qualification. 

8 Click Yes when the User Account Control dialog box appears asking ‘Do you 
want to allow this application from an unknown publisher to make changes 
to your PC?’ 

Administration of the ChemStationSystem Administrator Account 

During installation a local administrator account ChemStationSystem is added 
to the PC. If the PC is on a network/domain, for increased security this 
administrator should be created and administered on the domain. The 
ChemStationSystem must be designated as an administrator on the client PC, i.e. 
where the UV-Visible ChemStation has been installed. 

The locally created ChemStationSystem created on the client PC can be deleted 
or removed.  

NOTE During installation an administrator account ChemStationSystem is added to the PC. This 
administrator is created with a default password: ChemStation!1!System. If this password 
does not meet the current password policy requirements, the installation will fail. To 
proceed, temporarily turn off password requirements on the PC until the installation has 
successfully completed and then change the ChemStationSystem password as required. 

To confirm that the administrator account was created: 

For Windows 7: Click Start > Control Panel > System and Security > 
Administrative Tools > Computer Management > Local Users and Groups. 

For Windows 10: Right-click on Start and then select Control Panel > System and 
Security > Administrative Tools > Computer Management > Local Users and 
Groups. 
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Administration of the ChemStation administrator (ChemStationSystem) includes 
the following activities: 

1 Create a domain user named ChemStationSystem and make this user a local 
administrator.  

2 Give (NFTS-Permission) Full Control for ChemStationSystem on the 
following directories and files (see below for instructions): 

 C:\Chem32 

 C:\Chem32\core 

 C:\Chem32\uvexe 

 C:\Chem32\1 

 C:\Chem32\2 

 C:\Chem32\3 

 C:\Chem32\4 

 C:\Chem32\TMP 

 C:\Chem32\NonInst 

 C:\Windows\ChemStation,ini 

3 Remove all permissions (NFTS-Permission) for other non-administrator 
users, for example “Everyone”, except for Read and Read+Execute for the 
following file: C:\Windows\ChemStation.ini. 

4 Click Start > All Programs or All Apps > UV-Visible ChemStation > 
ChemStation System Configuration.  

NOTE The configuration tool is only available to administrators. 

5 Update the details in this dialog box to reflect the domain 
ChemStationSystem user credentials, specifically the domain (in the image 
below the PC exists on the Agilent domain) and password. 

 

Figure 3. Save ChemStation System Configuration changes 
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CAUTION If these details are not correct, you will not be able to start ChemStation. 

6 Ensure that the dialog “User Configuration Saved” is shown. 

7 This step needs to be performed on every client PC where UV-Visible 
ChemStation software has been installed. 

8 Log out of Microsoft Windows.  

9 Log into Windows using the ChemStationSystem account. Set up any 
printers that are to be used with the UV-Visible ChemStation while on this 
account. When finished log out. 

10 It is now possible to log on to the client PC and to the UV-Visible 
ChemStation software as a ChemStation user  

NOTE When using ChemStation, do not use the ChemStationSystem account. Agilent does not 
recommend using an Administrator account for ChemStation operation. 

Designating Folder Permissions 

1 Right click on the file or folder and then select Properties. 

 
Figure 4. Accessing the folder properties  

2 Go to the Security Tab and click Edit. 
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Figure 5. Opening the Edit Security dialog  

3 Click Add. 

4 Make sure the location is the domain that the PC is on, and type 
ChemStationSystem in the object name field, click OK and click OK again. 

 

 

Figure 7. Entering the object name 

5 Highlight the ChemStationSystem domain user that was just added and then 
select Full Control and click OK. 
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Figure 6. Applying permissions to ChemStationSystem account 

6 Repeat this for all of the folders described in the section above. 

7 Repeat this process for each domain user that is created for normal use of 
UV-Visible ChemStation, except click on “Read & execute”. 

Preparing the ECM Web Client 

To prepare the ECM Web Client: 

1 Ensure that an up-to-date version of the ECM Web Client is installed on the 
UV-Visible ChemStation computer. Refer to the OpenLAB ECM Installation 
Guide for more details. 

2 On the UV-Visible ChemStation computer: open a browser window and 
connect to the ECM Web Server. 

3 Log in to ECM. 

Click Yes if a dialog box asking if you want to install the hotfixes appears. 
Otherwise, all relevant hotfixes are automatically installed. You may be asked to 
restart the UV-Visible ChemStation computer during the installation. 
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Uninstallation 
To uninstall Agilent UV-Visible ChemStation, refer to the Agilent Cary 8454 
UV-Visible Spectroscopy System Installation Guide. To remove the UV privileges 
and roles from the ECM Server, contact your local Agilent representative.  
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This chapter describes how to log in to OpenLAB ECM in UV-Visible 
ChemStation, and explains the ECM-related user interface items and the main 
settings. 
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User Permissions 

Log In/Log Out 

To prevent unauthorized access to OpenLAB ECM or unauthorized use of UV-
Visible ChemStation, OpenLAB ECM requires authentication with a user name 
and password. In addition, each user must have user privileges defining the 
accessible content.  

The user administration is set up and managed on the ECM Server. For more 
details about ECM login and user setup refer to the ECM User/Administrator's 
Guide. 

For UV-Visible ChemStation, the login is mandatory and you must log in during 
the UV-Visible ChemStation startup.  

If you are already logged in to the UV-Visible ChemStation online session, and 
start the UV-Visible ChemStation offline session, you will need to re-enter a user 
name and password to login. 

If you are not connected to OpenLAB ECM, or the network connection is 
temporarily lost, you will be unable to access the UV-Visible ChemStation 
application. If connection is lost during a UV-Visible ChemStation session, you 
can continue until the file (results or method) will need to be saved. See 
Troubleshooting Saving and Retrieving Files to OpenLAB ECM on page 39. 

The login is dependent on the instrument session; only one user can be logged in 
to one instance of UV-Visible ChemStation at any one time. If another user wants 
to log in, the first user must log out. 

User credentials 

The Login dialog is displayed when UV-Visible ChemStation is launched. It 
requires you to enter a set of valid authorization details in order to log in. The 
login information is ECM Server-specific and will be provided by the ECM 
administrator. 

You must enter the following login details: 

 Server URL: the URL of the ECM Server. 

 Account: you can store content to the locations assigned in the specific 
account; one ECM Server may have several accounts. 

 Username: the user name defined in the ECM Account, or your NT domain 
user name (depending on the user configuration in ECM) 

 Log on to: the domain administrating the ECM users. 
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 Password: the password provided by your administrator, which can be 
changed on request (for ECM ‘built-in’ users), or the password of your NT 
domain account, if you are logging in using your NT domain user name. 

OpenLAB ECM User in UV-Visible ChemStation 

As long as a user is logged on, the UV-Visible ChemStation user name is given by 
the OpenLAB ECM logon and cannot be overwritten. This user name will appear 
in OpenLAB ECM system activity audit trails and UV-Visible ChemStation audit 
trails. 

Session lock 

If you leave the UV-Visible ChemStation computer for a certain period of time, 
you can lock the application so that no other user can access the program. This is 
a safety feature to ensure that there is no unauthorized access.  

When you activate the session lock, you or another user must first provide a 
valid login before continuing to work with UV-Visible ChemStation. 

There are the following options to activate the session lock: 

 Privately (ECM > Lock Session > privately in UV-Visible ChemStation): Only 
the user who activated the session lock, or a user with the UV: Break Session 
Lock privilege, can log in. 

 Non privately (ECM > Lock Session > non privately in UV-Visible 
ChemStation): Any valid ECM user can log in. This is useful, for example, if 
there is a shift change, and the leaving personnel secures UV-Visible 
ChemStation until the personnel of the new shift starts work. The new user 
privileges and profiles will be applied. 

 Time based: Depending on the ECM Account configuration, UV-Visible 
ChemStation is automatically locked after a given period of time without any 
user interaction (see Inactivity Timeout under Administration in ECM on 
page 46). If there is no activity in an OpenLAB ECM Web Client, the Web 
Client is also locked after the given period of time. UV-Visible ChemStation 
and the OpenLAB ECM Web Client are locked independently from each 
other.  

 Time base: UV-Visible ChemStation can be configured to lock automatically 
after a set amount of time within the ECM File menu. The number of minutes 
before the Session Lock is activated is set via ECM > Configure in UV-
Visible ChemStation.  This configuration is not saved until UV-Visible 
ChemStation is closed and you select the Save Configuration checkbox 
which appears before the application shuts down. The time based lock is 
broken by either a mouse click or by pressing a key on the keyboard.  
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 The time based session lock can be configured to lock the UV-Visible 
ChemStation session either privately or non-privately (see Log In/Log Out on 
page 28). 

OpenLAB ECM User Interface in UV-Visible ChemStation 

Overview of new interface elements 

With the installation of OpenLAB ECM Compliance Pack with UV-Visible 
ChemStation, the following new menus and menu items become available: 
 

Menu New Elements Description 

File View Signature Logbook Display the Signature Logbook 
 Add Signature Add a signature to the current result file within 

the UV-Visible ChemStation application (for a 
user with appropriate privileges) 

 Save Method Set the location to which the method will be 
saved in OpenLAB ECM. 

 Save Result Set the location to which the result will be 
saved in OpenLAB ECM. 

   

View Audit Trail See Audit Trails and Logbooks on page 44  
 Method Audit Trail  
 Sample Table Audit Trail (Advanced Mode)  
 Automation Table Audit Trail (Advanced 

Mode) 
 

 Self Test History (Verification and 
Diagnostics Mode) 

 

   

ECM Configure See The ECM menu on page 31 
 Change User  
 Lock Session  
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The ECM menu 

The ECM menu includes the following commands: 
 

Command Description 

Configure The configure menu allows for two key settings: 
• Default path and location for saving method and result files 

to the OpenLAB ECM. 
• Time based application lock 

Change User… Logs out the current user and opens the OpenLAB ECM login dialog. 
UV-Visible ChemStation cannot be accessed until a user with the 
appropriate privileges has logged in. 

Lock Session The UV-Visible ChemStation session can be locked either: 
• Privately 
• Non-privately 

(see Log In/Log Out on page 28) 

Automatic Data Transfer Settings 
There are no options to configure how data is transferred from UV-Visible 
ChemStation to the OpenLAB ECM database. Data transfer will be completely 
automatic, and the user will be prompted to save a results file before any further 
functions in the UV-Visible ChemStation application can be accessed. See 
Troubleshooting Saving and Retrieving Files to OpenLAB ECM on page 39 for 
more details. 

Compressed ChemStation File Formats and Legacy Data 
When UV-Visible ChemStation result files or verification files are uploaded to 
OpenLAB ECM, they are automatically packaged into an SSIZIP file. These files 
include the method, data and audit trail. All files that contain data must be saved 
as *.SSIZIP. 

The following table indicates which file types exist as compressed files.  
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UV-Visible ChemStation Non-ECM file type Packaging format 

Methods *.m No packaging 
Samples/Auxiliary *.sd Must be saved as part of Results file 
Standards *.std Must be saved as part of Results file 
Sample table 
(Advanced mode) 

*.st No packaging 

Automation 
(Advanced mode) 

*.a No packaging 

Standard mode results *.sr *.sr.SSIZIP 
Advanced mode results *.ar *.ar.SSIZIP 
Thermal Denaturation mode results *.td *.td.SSIZIP 
Kinetics mode results *.kd *.kd.SSIZIP 
Dissolution mode results *.dr *.dr.SSIZIP 
Verification and Diagnostics mode 
Self Test results 

*.sft *.sft.SSIZIP 

Verification and Diagnostics mode 
Diagnostics results 

*.dgr *.dgr.SSIZIP 

Verification and Diagnostics mode 
MCT Adjustment results 

*.mct *.mct.SSIZIP 

 

The packaging of UV-Visible ChemStation result files is a feature of the UV-
Visible ChemStation OpenLAB ECM Compliance Pack. The packaging is 
automatically carried out when the data or results are uploaded to OpenLAB 
ECM. When the SSIZIP files are downloaded from OpenLAB ECM to UV-Visible 
ChemStation, they are automatically unpacked.  

UV-Visible ChemStation method files can be uploaded to OpenLAB ECM, or 
transferred into OpenLAB ECM (where pre-existing method files are available), 
but can only be opened from within UV-Visible ChemStation. 

Sample, standard and auxiliary files can be transferred into OpenLAB ECM 
(where pre-existing files are available) and then opened from within UV-Visible 
ChemStation, but cannot be saved to OpenLAB ECM without being part of a 
results file that also includes method and audit trail information.  
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For the Advanced Mode of ChemStation, automation and sample tables can be 
saved to and loaded from OpenLAB ECM. Once an automation table is used to 
generate results, this must be subsequently saved as a results file including 
method, audit trail and data to ensure complete traceability of electronic 
records. 

Legacy data acquired with UV-Visible ChemStation prior to B.05.01 will have to 
be migrated to OpenLAB ECM before being able to be loaded into UV-Visible 
ChemStation. Legacy UV-Visible ChemStation results files (file extension: *.sr, 
*.ar, *.kr, *.tr or *.dr) will be able to be loaded from the OpenLAB ECM database 
to UV-Visible ChemStation, however will not contain an audit trail. It is possible 
to prevent further modification to these files by clicking on “Read Only” in the 
method transfer wizard tool. This prevents a new revision of the file being 
created in OpenLAB ECM. Methods, automations and sample tables will be able 
to be loaded into OpenLAB ECM, and subsequently used in UV-Visible 
ChemStation under 21 CFR Part 11 conditions. 
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This chapter describes the basic workflows with UV-Visible ChemStation 
OpenLAB ECM Compliance Pack. There are three data-related workflows and 
two workflows for methods. 
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Data-related workflows 

Workflow 1: Data acquisition and manual transfer to OpenLAB ECM  

Raw data and the results file are uploaded to the OpenLAB ECM directly after a 
collection is complete. The user can determine in which location the file is saved 
in the OpenLAB ECM database. The results file is compressed as a SSIZIP file. 

To save data to OpenLAB ECM manually after completion of a collection: 

1 Open UV-Visible ChemStation and log in to OpenLAB ECM. Your ECM user 
name is automatically inserted as the operator name. 

2 Create a method, or load a method from OpenLAB ECM. 

3 Collect spectra as per the UV-Vis method. 

4 Before the measurement commences, the UV-Visible ChemStation will 
prompt you to save the file: 

 Navigate within OpenLAB ECM to the preferred folder. 

 Indicate a name for the new SSIZIP file. 

5 A new OpenLAB ECM data set is created in the defined ECM location. The 
data set includes method, data and results, as a *.SSIZIP along with the 
application audit trail. 

NOTE The upload process may take some time when large amounts of data are uploaded. During 
this time UV-Visible ChemStation is busy and you cannot perform tasks in ChemStation. 
Please wait until the upload is completed. 

Workflow 2: Data acquisition using UV-Visible ChemStation Automation and automatic 
transfer to OpenLAB ECM  

UV-Visible ChemStation automation methods can be created in applicable modes. 
An automation method specifies a sequence of events that includes execution of 
the method, the file name and the file save location in OpenLAB ECM. The 
results file is saved automatically. 

1 An automation method is generated by a user with the appropriate privileges 
and uploaded to OpenLAB ECM. The ECM > Configure menu is used to 
define where the file is to be saved.  

2 A user with the appropriate privileges downloads the automation file from 
OpenLAB ECM and uses it to collect data. 
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3 At completion of the automation, the results file is automatically uploaded to 
OpenLAB ECM without any input from the user. The location in ECM where 
the file is saved and the file name is defined in the automation method. 

Workflow 3: Data acquisition using an existing UV-Visible ChemStation results file 

A UV-Visible ChemStation results file is created and saved in OpenLAB ECM as 
Version 1. As the result file contains the method, it can be loaded and used to 
collect more data, which changes the existing results file.  

1 An existing UV-Visible ChemStation results file (revision 1) is loaded from 
the OpenLAB ECM database. It contains method, data and audit trail 
information. 

2 The user makes changes to this results file by clearing results, collecting 
more data, changing the method or analyzing the existing data. If the user 
changes the method, they will be prompted with a Reason for Change dialog 
that is recorded in the application audit trail. 

3 The new results file is saved using the File>Save Results command (or saved 
with the same file name). 

4 Revision 2 of the results file is created in OpenLAB ECM. 

NOTE To review earlier versions of a file the user requires the ECM privilege Content: File Revisions 
– View. 

 

NOTE The ability to load earlier revisions of UV-Visible ChemStation files directly from OpenLAB 
ECM is available in ECM version 3.5 HF2 (or later). 

 

NOTE Locking the file during an electronic signature by selecting the “Lock Results” checkbox 
prevents a new revision of the results file from being created in ECM. After locking the 
Results, the file must be saved to apply this setting. 
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Workflows for Methods  

Overview of workflows for methods 

Workflow 1: Uploading a new method 

Newly created methods are manually uploaded to OpenLAB ECM. 

1 A new method is created by a user with the appropriate privileges in UV-
Visible ChemStation. 

2 The method and its associated audit trail are uploaded to OpenLAB ECM 
using the path selected by the user in the File > Save Method As menu 
command. 

3 Revision 1 of the method is automatically created in OpenLAB ECM. 

Workflow 2: Saving a changed method 

An existing method can be opened in UV-Visible ChemStation and changed by a 
user with the appropriate privileges. The method can then be saved again in the 
ECM. 

1 From UV-Visible ChemStation, an existing method is loaded from ECM. 

2 The method is edited by a user with the appropriate privileges. 

3 The user will be prompted with a Reason for Change dialog to enter user 
credentials and a reason for the change. This is saved in the application audit 
trail. 

4 The method is uploaded to OpenLAB ECM using the path selected by the 
user: 

• Use the File > Save Method menu command to save to the same 
location and with the same file name. In this case revision 2 of the 
method file will be created. 

• Use the File > Save Method As menu command to save the method 
to a new location with a new file name. 

5 After finishing the upload, the file is available in OpenLAB ECM.  

Results Files, Data Recovery and Reporting 
In all ChemStation modes, a results file must be saved as soon as data is 
collected, a sample is removed or data is reanalyzed. At the end of the sequence 
or measurement, the results file is saved to OpenLAB ECM.   
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The data recovery feature ensures that data generated during a measurement 
sequence cannot be deleted or lost, for example, due to a PC power failure. A 
temporary file is generated in a protected location on the PC, and exists until the 
results file transferred to OpenLAB ECM. If a power failure occurs before the 
results file is saved, the user will be notified when the ChemStation software is 
relaunched. The results file must be saved before the user can continue with 
ChemStation operation. 

The result file comprises all raw spectra, removed spectra, an audit trail, and a 
signature logbook.  

Reports generated from all modes of ChemStation include all components of the 
result file. For Advanced Mode, the Manager must configure the GLP Report 
Template to be used.  

By saving all information to a single file it is ensured that the original results can 
be reproduced during an audit.  

Troubleshooting Saving and Retrieving Files to OpenLAB ECM 
ECM Server is not available 

If the ECM Server is not available while working with UV-Visible ChemStation, 
there are two possible scenarios. 

 ECM Server is not available before/during login 

If the ECM Server is not available while logging in to OpenLAB ECM 
during UV-Visible ChemStation start up, the user cannot be 
authenticated by the system. Login is aborted and there will be no access 
to UV-Visible ChemStation. 

 ECM Server is not available at the time a file is being saved 

If the ECM Server connection is interrupted at the time a file is being 
saved, the file save event will fail and the user will be notified by an 
error message. To prevent loss of data, UV-Visible ChemStation will not 
allow any further actions until the file has been saved. 

When the ECM Server becomes available again, the file save can occur, 
and the user can continue. As soon as the ECM Server is available again, 
all OpenLAB ECM tasks are available without restarting the application. 
A new login is not required. 

If a successful file save has not occurred, the file can be recovered from a secure 
location on the hard disk (c:/Chem32/TMP). When the ECM Server is available, 
the file must be transferred to OpenLAB ECM before it can be opened by UV-
Visible ChemStation. The file will only be at this location until a new file is 
created in UV-Visible ChemStation and saved to OpenLAB ECM.  

For further troubleshooting, please contact your ECM administrator. 
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This chapter explains the purpose of 21 CFR Part 11 and its implementation in 
UV-Visible ChemStation with ChemStation OpenLAB ECM Compliance Pack. 
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Introduction to 21 CFR Part 11 
Effective August 20, 1997, the U.S. Food and Drug Administration (FDA) 
released and published a new rule to enable pharmaceutical companies to 
approve their results with electronic signatures and to transfer paper-trail 
documentation into electronic records. This rule is known as 21 Code of Federal 
Regulations Part 11 (referred to as 21 CFR Part 11) and applies to all industry 
segments regulated by the FDA. 

The impact of this rule on current work practices and data handling in the 
pharmaceutical industry has been much higher than expected. “The industry 
wanted to have a rule on electronic signatures, but what they got was a rule on 
electronic records.” (Martin Browning, former FDA inspector, during a 
validation seminar in Washington D.C.) 

21 CFR Part 11 places high emphasis on the implementation of all measures to 
protect and secure electronic records. Notwithstanding the uncertainties and the 
changes that 21 CFR Part 11 requires in the behavior of both the pharmaceutical 
industry and the vendors of chemical analysis equipment, it is well worth 
implementing in today’s laboratories because it can help the industry with one of 
the most important issues in pharmaceutical research-bringing new drugs on the 
market faster. 

The major benefits of this shift towards electronic data management are in the 
potential productivity increase for the industry. The industry can decrease its 
data output on paper, speed up the data review and approval process, and 
benefit from new automation technology based on computerized system control, 
for example, in manufacturing or dissolution drug release testing. 

In addition to this rule on electronic records, other general requirements for 
computerized systems are brought to the auditor’s attention. These rules cover 
the basic requirements of validation, limiting data access and ensuring data 
integrity and data traceability.  

It is, of course, the industry that must ensure that its work practices support the 
FDA rules, but most of the requirements also affect the chemical analysis 
systems and suppliers of these systems. 

21 CFR Part 11 Requirements 
To fulfill the FDA rules and guidelines for electronic records and computerized 
systems, it is important to understand the basic aspects of secure data handling. 

 Data security: physical protection of data by limiting access to the system 
and preventing unauthorized access. 
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 Data integrity: protecting raw data and metadata from corruption and 
unauthorized modification; linking raw data and results to allow the original 
results to be reproduced at any time, for example, for an audit. 

 Audit traceability: documenting which user did what to the results and 
when; tracing any modifications to the original raw data. 

General Aspects of Data Security in Computerized Networks – Open Versus 
Closed Systems 

It is generally known that data transfer over a public network can be accessed by 
unauthorized external persons, “hackers”, who gain access either for personal 
amusement or intentional fraud.  

If an electronic identification comprising user ID and a password is used to 
approve confidential or important data, users must be sure that their signatures 
are unbreakably linked to the data and that nobody can copy this signature or 
get access to the passwords. In a public system, this would require additional 
encryption technology, for example, a private/public key combination of data 
encryption. In contrast, if a computerized system is protected from unauthorized 
access, users can be sure that their signatures are private and are not accessible 
to unauthorized individuals. 

The FDA also distinguishes between these two scenarios and defines them as 
open and closed systems. A public network system can therefore only be viewed 
as an open system and a protected network as a closed system, if it fulfills 
additional requirements. 

In FDA terms, “closed system means an environment in which access is 
controlled by persons who are responsible for the content of electronic records 
on the system” (11.3.5). The evidence of a system being a closed system is not a 
one-time check but an ongoing process of executing and documenting the system 
controls that make sure that the system is closed. In contrast, in an open system, 
“those persons being responsible for the content of electronic records do not 
control the system access.” 

As a result, open systems require additional encryption technology for all data 
transfer over the network. 

UV-Visible ChemStation OpenLAB ECM Compliance Pack is designed for, and is 
supported in, closed systems. 
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Overview of Configuration Steps Required for Part 11 
To configure UV-Visible ChemStation OpenLAB ECM Compliance Pack to be 
compliant with 21 CFR Part 11, you must ensure that your system complies with 
this checklist: 

 LCDF structure on the ECM Server prepared according to your needs See 
Data Storage in OpenLAB ECM on page 11. 

 UV-Visible ChemStation specific roles and privileges added to the ECM 
Server. See Updating roles in existing OpenLAB ECM Accounts on page 14. 

 OpenLAB ECM Roles/Users/Groups configured. See Configuring users, roles 
and privileges on page 15. 

 ECM Account configuration with active audit trail and mandatory reason. 
See ECM Audit Trail on page 45 and Account configuration on page 46. 

 Password policy realized in ECM (including E-mail Notification). See To 
configure the password settings for an ECM Account on page 47. 

 E-Signatures prepared (messages and privileges). See Using electronic 
signatures on page 49. 

 UV-Visible ChemStation with ChemStation OpenLAB ECM Compliance Pack 
installed on the Client PC. See In addition to the OpenLab ECM roles… on 
page 17. 

 Audit trail will automatically be active and cannot be switched off. 

Audit Trails and Logbooks 
In order to comply with 21 CFR Part 11, UV-Visible ChemStation OpenLAB ECM 
Compliance Pack offers two audit trails and logbooks to document all activities 
associated with methods, results, reports, or with ECM files generally. These 
audit trails and logbooks track all changes that are made to any file, including 
data acquisition, re-analysis, and long-term archiving. 

The audit trails are stored together with the methods, sample data, and self-test 
results. The audit trail files are archived together with the other data in the 
associated SSIZIP files. The ECM logbooks are available only directly in ECM. 

UV-Visible ChemStation Audit Trail 

A single audit trail in UV-Visible ChemStation captures all actions associated 
with editing methods and results. The audit trail contains information on: 

• A description of the action or event that has occurred in the software 

• The ECM user that is the ChemStation operator at the time 
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• Time and date of the event 

• Serial number of instrument (for online UV-Visible ChemStation) 

• Name of the PC/workstation 

• Relevant filename 

• A user-entered reason where applicable 

For specific operations, the user will be prompted to enter a reason that is 
recorded in the application audit trail. For example, if the user opens an existing 
method and makes changes to the method, the user will be prompted to enter a 
Reason for Change when the new method is saved. If a measurement is 
occurring and the user stops the measurement sequence prematurely, the user 
will be prompted to enter a Reason for Stop. 

Signature Logbook 

In UV-Visible ChemStation you can add an electronic signature to a file with a 
valid user ID and password. The signature logbook records the time and date of 
the signature, the user who applied the signature and the reason the signature 
was applied. In order to sign a UV-Visible ChemStation file, you must have the 
appropriate privileges. 

ECM Audit Trail 

The ECM Audit Trail is a record showing who accessed the system and what 
operations he or she performed during a given period of time. 

You can view file-related, system administration, folder administration, and 
scheduler-related entries. For example, you can see when a file was added and 
who added it. 

For each operation, ECM prompts you to provide a reason. This Reason is also 
shown in the ECM Audit Trail. For automatic uploads there are default reasons 
given by the system. The Reason entry may be optional or mandatory, depending 
on the ECM configuration (see Account configuration on page 46). If the system 
is configured to support compliance with 21 CFR Part 11, providing a reason is 
mandatory. 

ECM System Log 

The System Log is a record that shows changes to the system, including 
configuration changes, e-mail notifications, and additions or changes of 
Locations, Cabinets, Drawers, or Folders. 
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You can view file-related, system administration, folder administration, or 
scheduler-related entries. For example, you can see when a Location was added 
and by whom. 

The System Log is always active; you do not need to enable it. 

To view the ECM System Log 

1 In ECM, select the Administration page. 

2 In the navigation pane, select the Activity Log > System Log node. 

All general actions related to ECM are listed here, together with the date, ECM 
user name who performed the action, and a reason provided by the respective 
user. Depending on the ECM Account administration, the reason may be optional 
or mandatory (see Account configuration on page 46). 

You can search the entries, for example, for a specific date or date range, or for 
entries related to specific categories (Files, Folders, System, Scheduler, or 
Instrument). Also you can print the entries or export them to a file. 

Administration in ECM 
When you install UV-Visible ChemStation OpenLAB ECM Compliance Pack, you 
need to carry out certain basic configuration tasks in ECM (see Installation and 
Configuration Tasks on the Server on page 14). In addition, there are several 
other settings in ECM that are relevant with regard to 21 CFR Part 11. These 
settings are described in the following section. 

Account configuration 

To configure the ECM Account 

1 In ECM, select the Administration page. 

2 In the Navigation Pane, select the Account Administration node. 

3 Double-click the Configuration item.  

4 The Account Administration dialog opens. 
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5 Apply the following settings: 
 

Setting Description 21 CFR Part 11 
Requirements 

Lockout A user who tries too often to log in with invalid 
user credentials is locked out of the system and 
no longer log in — even with valid user 
credentials. You can define the number of login 
attempts permitted. 

Limit the number of 
allowed login attempts 
to three. 

Inactivity Timeout A user who does not perform any action in UV-
Visible ChemStation or the ECM Web Client for 
the given period of time is automatically logged 
out.  

Specify a timeout 

System 
administrator email 

Specifies an e-mail address that is notified when 
a user is locked out after too many unsuccessful 
login attempts. 

Provide an email 
address 

Minimum Password 
Length 

Specify the minimum number of characters 
required in any new password. The default 
setting is 5. 

Require a minimum 
password length of at 
least 5 characters 

Require entry in 
Reason fields 

In each ECM Audit Trail or System Log entry, 
users can enter a reason for the action. If this 
check box is selected, the reason entry is 
mandatory. 

The ECM Audit Trail 
and System Log 
reasons must be 
mandatory 

Users/Groups/Roles 
To configure the password settings for an ECM Account 

NOTE 21 CFR Part 11 requires that a company/laboratory has a password policy. 

1 In ECM, select the Administration page. 

2 In the navigation pane, select the Account Administration node. 

3 Double-click the Users/Groups/Roles item.  

The Account Administration dialog opens. 

21 CFR Part 11 does not define any specific rules for the password settings. 
However, your company must have defined a password policy. You may consider 
the following settings: 

 User cannot change password 

 User must change password after next login 
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Note that the minimum password length is defined in the ECM Account 
configuration (see Account configuration on page 46). 

Roles and folders 

ECM allows you to assign specific roles to users or user groups. This can be done 
at the global level for the entire ECM Account, or individually for specific folders. 
For example, a specific user group may have the Contributor role for folder A, 
but at the same time have only the Reader role for folder B. 

If you want to assign roles at the folder level, you must first enable this feature in 
ECM. The setting is valid for the complete ECM Account. 

To enable roles for folders: 

1 In ECM, select the Administration page. 

2 In the navigation pane, select the Account Administration node. 

3 Double-click the Users/Groups/Roles item.  

The Account Administration dialog opens. 

4 On the Roles tab, select the required role and click Edit. 

5 Select the Available in folder access tab check box. 

Electronic Signatures in ECM 
Electronic signatures provide a means to sign documents as equally binding as a 
handwritten signature. In addition, electronic signatures are reproducible, 
because they are recorded in a secure, time stamped audit trail. Manipulation is 
prevented by enabling only users with specific privileges to sign electronically. 

An electronic signature contains the user name (full name), date, and time when 
the signature was applied, the location where the signing occurred, and a user-
configurable definition associated with the signature. The signature is always 
related to the complete SSIZIP container, not to a single file inside the container. 

With the help of the Agilent OpenLAB Business Process Manager (BPM) module, 
you can create highly automated review or approval processes including e-mail 
notification. 
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Preparation 

Privileges 

An ECM user must have the privilege Content: File Signatures to sign 
electronically. This privilege is, for example, assigned to the ECM default role, 
:Approver. 

Reasons for the signature 

With each signature the ECM users must either select a given reason or, if they 
are allowed to, provide their own reason.  

To configure the reasons for signatures: 

1 In ECM, select the Administration page. 

2 In the navigation pane, select the Account Administration node. 

3 Double-click the Electronic Signature item. 

The Account Administration dialog opens. 
To provide a new reason, enter the required text into the Reasons field and 
click   

To delete an existing reason, select the reason in the Default reasons list and 
click  

If you want to allow users to provide their own reason with a signature, select the User can 
specify reason check box.  
Note that if you clear this check box, the users can only select one of the given default reasons. 

 

4 If necessary, adjust the timeout settings: 

 The Signature screen timeout defines how long an e-signature dialog will 
stay open if no signature is submitted. The default setting is 5 minutes. 

 The Consecutive signature timeout is relevant if an ECM user carries out 
several successive e-signatures. If the next e-signature takes place within the 
given timeout interval, the location and the reason provided in the first e-
signature will be pre-filled in the next dialog. The default setting for the 
consecutive signature timeout is 5 minutes. 

Using electronic signatures 

To apply an electronic signature 

1 Right-click the required SSIZIP container and select Electronically Sign > 
Electronic Signature from the context menu. 

The Electronic Signature dialog opens. 
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NOTE The other command in the context menu, Electronically Sign > Acrobat Plug-In Signature, 
works only for PDF documents and only if you purchased the appropriate plugin. It enables 
you to add signatures directly inside PDF documents. 

2 Enter your ECM user credentials (username, password, and domain). 

3 Enter your current location. With this information, the location from where 
you provide the signature is reproducible. 

4 Select a reason for the signature from the Default reason drop-down list. 

- Or - 

Select the User specified check box and enter a different reason into the text 
field. Note that this option is only available if the ECM Account is configured 
accordingly. 

5 Click Sign. 

6 The file is now signed electronically. The e-signature is shown in the file 
properties in the eSig tab. The e-signature is also included in the ECM Audit 
Trail. 

The user preferences in ECM can be configured in such a way that the number of 
e-signatures applied to a file is shown by default in the ECM content display, 
together with the file name and status. 

The electronic signature itself is shown in the file properties in the eSig tab, and 
it is also part of the ECM Audit Trail. 

 

To adjust the user preferences:  

1 In ECM, select the Administration page. 

2 In the navigation pane, select the Account Administration node. 

3 Double-click the User Preferences item. 

4 Click Modify... to modify the column settings. 

5 Select # of signatures and click   to add this property to the selected 
columns. 

6 Click OK. 

7 The number of e-signatures is then shown on every content page in ECM.



 
 

 
  51 

6.  Appendix 

ChemStation Privileges in ECM ............................................... 52 
UV-Visible ChemStation Roles in ECM .................................. 54 
ECM related privileges for the UV-Visible ChemStation 
configuration ............................................................................... 58 
  



Appendix 
 

52  OpenLAB ECM Compliance Pack Concept Guide 

ChemStation Privileges in ECM 
 

Privilege Description 

UV: Standard Mode Method Edit: Change any method in Standard mode.  

UV: Advanced Mode Method Edit: Change any method in Advanced mode.  

UV: Thermal Denaturation Mode Method Edit: Change any method in Thermal Denaturation mode. 

UV: Kinetics Mode Method Edit: Change any method in Kinetics mode. 

UV: Dissolution Mode Method Edit: Change any method in the Dissolution modes: 
Dissolution Testing 
Multibath Dissolution Testing 

UV: Sample Run: Ability to measure a sample, or load Samples from 
the ECM database 
Edit: Allows you to Clear > Standards 

UV: Standards Run: Ability to measure a standard, or load Standards from 
the ECM database 
Edit: Allows you to Clear > Standards 

UV: Auxiliary Run: Ability to measure an auxiliary, or load Auxiliaries 
from the ECM database 
Edit: Allows you to Clear > Standards 

UV: Standard Mode Analyze Run: Change a results file by analyzing.  
Access the Math menu. 

UV: Advanced Mode Analyze Run: Change a results file by analyzing.  
Access the Math and Optimize menus. 

UV: Thermal Denaturation Mode Analyze Run: Change a results file by analyzing.  
Access the Math menu. 

UV: Kinetics Mode Analyze Run: Change a results file by analyzing.  
Access the Math menu. 
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Privilege Description 

UV: Dissolution Mode Analyze Run: Change a results file by analyzing.  
Access the Math menu. 

UV: Report Setup Run: Enables editing of reports in applicable ChemStation 
modes: Advanced, Dissolution Testing, Multibath 
Dissolution Testing and Combined Reports 

UV: Combined Report Dissolution Mode Edit: Provides access to ‘Acceptance’ menu to allow 
setting of type of release  
Run: Allows reports to be calculated 

UV: Validation Run: Access to Verification and Diagnostic Mode tasks 

UV: Sign Add: Ability to add a Signature (using user ID and 
password) to a UV-Visible ChemStation file. 
View: View access to signature logbook 

UV: Approve Add: Ability to lock a result by checking the ‘lock’ box on 
the Add Signature dialog 

UV: Break Session Lock Run: Ability to unlock sessions that have been locked by 
any user 

UV: Configuration Edit: Provides access to the ECM  > Configure menu, 
which allows setting of default file save locations (for 
Automations) and also time based lock settings. See The 
ECM menu on page 31 

UV: Command Line None 

UV: Modify Report Edit: Ability to create new Report Styles and to modify 
existing Report Styles 

UV: Read Only Run: Users with this privilege will only be able to run 
ChemStation in offline mode. This privilege will override 
any other UV: privilege that has been assigned. 
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UV-Visible ChemStation Roles in ECM 
 

Default UV:Administrator privileges 

Privilege View Edit Add Run 

UV: Sample  X   

UV: Standard  X   

UV: Auxiliary  X   

UV: Report Setup    X 

UV: Combined Report Dissolution Mode    X 

UV: Validation    X 

UV: Sign X    

UV: Break Session Lock    X 

UV: Configuration  X   
 

Default UV:Analyst privileges 

Privilege View Edit Add Run 

UV: Standard Mode Method  X   

UV: Advanced Mode Method  X   

UV: Thermal Denaturation Mode Method  X   

UV: Kinetics Mode Method  X   

UV: Dissolution Mode Method  X   

UV: Sample  X  X 

UV: Standards  X  X 
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Default UV:Analyst privileges 

Privilege View Edit Add Run 

UV: Auxiliary  X  X 

UV: Standard Mode Analyze    X 

UV: Advanced Mode Analyze    X 

UV: Thermal Denaturation Mode Analyze    X 

UV: Kinetics Mode Analyze    X 

UV: Dissolution Mode Analyze    X 

UV: Report Setup    X 

UV: Combined Report Dissolution Mode  X  X 

UV: Sign X  X  

UV: Break Session Lock    X 
 

Default UV:Operator privileges 

Privilege View Edit Add Run 

UV: Sample  X  X 

UV: Standards  X  X 

UV: Auxiliary  X  X 

UV: Standard Mode Analyze    X 

UV: Advanced Mode Analyze    X 

UV: Thermal Denaturation Mode Analyze    X 

UV: Kinetics Mode Analyze    X 

UV: Dissolution Mode Analyze    X 
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Default UV:Operator privileges 

Privilege View Edit Add Run 

UV: Report Setup    X 

UV: Combined Report Dissolution Mode    X 

UV: Sign X  X  
 

Default UV:Lab Manager privileges 

Privilege View Edit Add Run 

UV: Sample  X   

UV: Standard  X   

UV: Auxiliary  X   

UV: Standard Mode Method  X   

UV: Advanced Mode Method  X   

UV: Thermal Denaturation Mode Method  X   

UV: Kinetics Mode Method  X   

UV: Dissolution Mode Method  X   

UV: Standard Mode Analyze    X 

UV: Advanced Mode Analyze    X 

UV: Thermal Denaturation Mode Analyze    X 

UV: Kinetics Mode Analyze    X 

UV: Dissolution Mode Analyze    X 

UV: Report Setup    X 

UV: Combined Report Dissolution Mode  X  X 
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Default UV:Lab Manager privileges 

Privilege View Edit Add Run 

UV: Sample  X   

UV: Standard  X   

UV: Auxiliary  X   

UV: Sign X    

UV: Approve   X  

UV: Break Session Lock    X 

UV: Modify Report  X   
 

Default UV:Service privileges 

Privilege View Edit Add Run 

UV: Sample  X   

UV: Standard  X   

UV: Auxiliary  X   

UV: Standard Mode Method  X   

UV: Advanced Mode Method  X   

UV: Thermal Denaturation Mode Method  X   

UV: Kinetics Mode Method  X   

UV: Dissolution Mode Method  X   

UV: Standard Mode Analyze    X 

UV: Advanced Mode Analyze    X 

UV: Thermal Denaturation Mode Analyze    X 
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Default UV:Service privileges 

Privilege View Edit Add Run 

UV: Kinetics Mode Analyze    X 

UV: Dissolution Mode Analyze    X 

UV: Report Setup    X 

UV: Combined Report Dissolution Mode    X 

UV: Validation    X 

UV: Sign X  X  
 

 

 

Default UV:Read Only privileges 

Privilege View Edit Add Run 

UV: Sign X    

UV: Read Only    X 
 

ECM related privileges for the UV-Visible ChemStation configuration 
Please note: the default UV-Visible ChemStation roles do not contain any ECM 
privileges and these will need to be added as needed. The privileges described in 
the following table must be assigned to at least one of the ChemStation roles in 
order to become active. For more information about ECM privileges and profiles 
refer to the ECM Administrator’s Guide. 
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Privilege View Edit Delete Add Run Description 

Content: File X   X  Minimum privilege for UV-Visible 
ChemStation to access ECM 

Content: File Filtering  X    Minimum privilege for UV-Visible 
ChemStation to access ECM 

Content: File Revisions X     Privilege to view revisions  

Content: File Type [XLS]  X  X  Privilege to add and check in files with an 
.xls extension 

Content: Folder X X  X  Minimum privilege for UV-Visible 
ChemStation to access OpenLAB ECM 
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